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Licensing and Copyright Information 

The software described in this guide is furnished under license agreement and is used in terms of 
accordance only. 

Product Version: eViewer (SilverLight) v 1.5 

Document Version: 1.1 

© 2013 MS Technology. All rights reserved. 

This guide and accompanying software are confidential and proprietary to MS Technology. No part 
of this document can be copied, modified, reproduced, republished, uploaded, or distributed in any 
form by any means without prior authorization of MS Technology. Unauthorized use of the 
information appearing here may violate copyright, trademark and other applicable laws, and could 
result in criminal or civil penalties. 

The information provided in this document is used as a guide only and is subject to change without 
any notice. MS Technology reserves the rights to change and update their product or make changes 
in the context without any obligation to notify any person for such changes. 

MS Technology,                                                                                                                                
P.O. Box 471843                                                                                                  
Charlotte, NC 28247                                                                                                               
USA 

Tel: 704-544-3403                                                                                                                  
Fax: 704-544-0262                                                                                                                                 
Email: info@ms-technology.com                                                                                                          
Website: www.ms-technology.com 

If you find a typographical error in this manual, or if you have thought of a way to make this manual 
better, we would love to hear from you, feel free to share with us at info@ms-technology.com.  
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1. Getting Started 

This section lets you get introduced with various sections covered in this user manual which further 
helps you in understanding the product, eViewer (SilverLight) in a better way. You can also 
understand the purpose of developing such product. This user guide also contains key features with 
the system requirements for proper installation and use of product.    

1.1 Brief about User Guide 

Welcome to the user guide of eViewer (SilverLight) which is proficient, competent and result-
oriented product. This user guide has been designed in such a way that the user is able to understand 
the software in an efficient and effective manner. So we recommend you to carefully go through the 
user guide before launching the product and keep it in a safe and easily accessible place for future 
reference. 

1.2 Overview 

eViewer (SilverLight) is a powerful and robust document viewing web based application that allows 
users to view images and documents stored in a SharePoint repository. Its main function is to view 
different file formats including PDF, TIFF, JPEG, MS Office, IBM proprietary file formats, and 
many others. It also allows users to view, manipulate, redact, print and annotate documents and 
images stored within almost any ECM system. 

1.3 Features 

eViewer (SilverLight) is loaded with rich features that make it complete and outstanding. Some of 
the features are listed below: 

 Cross Internet browser Silverlight / JavaScript viewer. 

 Local document cache or global / shared document caching under load balance WFE 
servers. 

 Compatible with Windows mobile or Windows tablet browsers to view documents from 
SharePoint. 

 Supports deployment on load balanced environment. 

 Easy Installation, configuration and license deployment / activation procedures. 

 Embedded SharePoint document explorer to search document in SharePoint to open 
documents from within the viewer’s user interface. 

 Version controlling (Check-Out / Check-In / Discard-Check-Out) process embedded 
within the viewer. 

 SharePoint web-part to export all documents of a document library with their annotations 
to a desired format. 

 Java script & Scriptable Silverlight API’s to add custom toolbar buttons to existing tabs or 
add new tabs to the viewer and add toolbar buttons to it with their implementation. 

 Blogs on annotations. 
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 Bookmark pages with comments. 

 Searching bookmarks with comments. 

 Enhance Document. 

1.4 Benefits 

eViewer (SilverLight) provides benefits in a variety of following ways: 

 Reduce Overhead and Increase Productivity: Allows companies to reduce a number of 
applications to one efficient universal document and image viewer.  

 File Formats: Supports over 50 common and proprietary file formats. 

 Annotations: Access to a number of different annotations including, but not limited to 
redaction, line, arrow, rectangle, circle, polygon, polyline, curve, closed curve, text, note, 
highlighter, pen, stamp, watermark, etc. 

 Internal Development: All file formats are developed by in-house MST developers and do 
not use any third party APIs. This gives you the ability to have customization, prompt 
resolutions to issues, and release control. 

 Local document cache or global / shared document caching under load balance 
WFE servers: Provide cache configuration setting to work under a load balanced 
environment. Administrators can allocate a common or global document cache for multiple 
WFE servers to improve the overall performance and to prevent unnecessary calls to 
database server also reducing the overall cache size and preventing same files from caching 
at multiple locations. 

 Compatible with Windows mobile or Windows tablet browsers: Provides instant access 
to all data and corporate files from any Windows mobile or tablet to view documents from 
the ECM. Access to the data will be secure, synchronized, and instantaneous. 

 Embedded SharePoint document explorer to search document in SharePoint to open 
documents from within the viewer’s user interface: Provides the list of all documents 
and files exist in Library and sites and provides access to view any document within the 
viewer interface. Can view all SharePoint documents list and libraries within the viewer itself. 

 Export all documents of a document library with annotations: Provides facility to 
export all documents available in the ECM repository with annotations made in the file in 
the other file format and can save it at the local directory. 

 Encrypting region of document’s with user passwords: Protect your text and encrypt 
documents. Add security to a Word document by making your document password-
protected. The next time you open it, or if someone else opens it, a password prompt will 
open. No one will be able to open the document without the password. 

 User can search linked documents in the document currently open, based on the content 
type setting in the SharePoint library. 

 Users can search related documents in the document currently open, based on the metadata 
of the current document. 
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1.5 Supported File Formats 

eViewer (SilverLight) supports the following file formats: 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PDF 
TIFF 
JPEG 
BMP 
GIF 
PCX 
DCX 
IBM (MO:DCA, IOCA, PTOCA) 
Email (MSG, EML) 
WBMP 
ASCII 
MS Office (Word, Excel, PowerPoint) 
PNG 
DMG 
CAD (DWG) 
OCR 
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1.6 System Requirements 

Before continuing further, please make sure you have the minimum system requirements as 
specified below:  

Hardware Requirements 

Server: 
 
Processor: 2 GHz or faster 
Memory: Min 2 GB RAM 
Available Disk Space: Min 20 GB 
 
Desktop:  
 
Memory: Min 1 GB RAM 
Available Disk Space: Min 5 GB 

Software Requirements 

Server: 
 
Windows Server 2008 or higher 
Application Server - IIS 5.1 or above  
 
 
Desktop: 
 
Window XP or higher 
Silverlight 5.0 
Internet Explorer 7.0 or above, Firefox 3.6 or above, Chrome 12 or above  
.NET Framework 4.0 
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2. Understanding Interface 

A user interface is the means by which you are able to communicate with the application. eViewer 
(SilverLight) has a very user friendly and intuitive user interface that provide quick access to all 
important functions making an application very simple, efficient and informative.    

                           

  

 

 

2.1 The Ribbon 

Ribbon combines the menu bar and toolbar into a single floating pane. The purpose of the ribbon is 
to bring the most popular commands to the forefront, so you don’t have to search for commands in 
the viewer you do all the time.  

Additionally, the ribbon includes several tabs that are used to reveal different groups of commands. 
Since the ribbon contains both the program's menu options and toolbar commands, it cannot be 
removed from the screen.  

The Ribbon offers ease of use and convenience, with all common actions shown at one place.  The 
Ribbon has three parts. They are – tabs, groups, and commands that have replaced traditional 
menus and toolbars.  

 

Document View Area 

Tabs 
Group 

Ribbon 

Command Quick Access Toolbar 

Show 

or hide 

ribbon 

Application 

icon 

User Name 
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Tabs 

The Ribbon has three basic tabs (Home, View, and Annotations) across the top with each tab 
represents an activity area with their own specified commands.  

 

By default, the Home tab is displayed when the viewer is opened. 

 

Groups 

Commands are sectioned into groups within each tab. 

                                    

 

Commands 

A Command is a button or a box or a menu where you enter information. Each group has their own 
specified commands that are useful in managing any type of file.  
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In the above group,  ( ) and ( ) are commands. 

2.2 Toolbars and Tabs 

eViewer (SilverLight) has one main toolbar that allows modifying any type of file. This main toolbar 
i.e. File Tab contains options that allows to Save, Close, Export, Print, etc. any type of file. 

 

Home Tab 

This is the standard view tab that incorporates features such as page navigation, zooming, rotation, 
clipboard, editing, etc. This tab has eight groups with each group have their commands that 
performs their specified task.     
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Group Name Commands Command Decription 

 

Clipboard 

 
Cut: Cuts the selected text or image or 
annotation from a page. 

 Copy: Copies the selected text or image 
or annotation from a page. 

 

Paste: Inserts the copied text or image 
or annotation at the insertion point 
(cursor). 

 

 

Zoom 

 
Zoom In: Increases the magnification 
percentage of the page. 

 
Zoom Out: Decreases the 
magnification percentage of the page. 

 
Fit to Window: Resize the document 
to fit entirely in the window. 

 Fit to Width: Resize the document to 
fit entirely in the width of the window. 

 
Fit to Height: Resize the document to 
fit entirely in the height of the window. 

 
Actual Fit: Bring the document into its 
actual size. 

 

Rotation 

 Rotate Counterclockwise: Rotate the 
page in an anti-clockwise direction. 

 
Rotate Clockwise: Rotate the page in a 
clockwise direction. 

 Rotate 180°: Rotate the page at 180° 
direction. 

 

 

Navigation 

 First Page: Displays first page of the 
document. 

 
Previous Page: Displays previous page 
of the document. 

 Next Page: Displays next page of the 
document. 

 Last Page: Displays last page of the 
document. 

 

Email  

Link: Send document link via mail to 
other person. 

 

Bookmark: Way to navigate within a 
document. 

Search 

 

Quick Find: Searches text in a 
document. 



           
eViewer (SilverLight)                                                                                                                                                                                                       

 
User Manual    
Document Version: 1.1                                                                                                                13 
 

 

Editing 
 

PDF Redaction: Hide certain type of 
information from documents such as 
SSN, text and even images too. 

 

Extract Content: Extract content from 
images (and not only) and convert it 
into an editable text. 

Scan 

 

Scan New: Scans images through 
scanner and view it in the viewer. 

View Tab 

This tab provides major operations that can be done on the document such as image processing 
opeartions. This tab has two groups with each group have their commands that performs their 
specified task. 

 

Group Name Commands Command Decription 

 

 

Image Processing 

 Invert Colors: Invert the 
color of the page. 

 
Horizontal Flip: Flip page  in 
horizontal direction. 
 

 
Vertical Flip: Flip page  in 
vertical direction. 

 

Window 

 
Split Horizontal: Split page  
in horizontal direction. 

 
Split Vertical: Split page in 
vertical direction. 

 
Synchronous Scrolling: View 
two documents simultaneoulsy 
at the same time. 
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Annotation Tab 

This tab displays list of annotation tools available in the viewer with some other features such as 
adding bookmarks and watermark. This tab has six groups with each group have their commands 
that perform their specified task. 

 

The description of each annotation tool with their properties is described later in the manual. For 
details, refer to the section Annotation.   

 

Group Name Commands Command Decription 

 

Encryption  

Encrypt: To encrypt sensitive 
and confidental information 
such as Account No, Social 
Security Number, etc. 

 

Decrypt: To decrypt sensitive 
and confidental information. 
 

 

 

Add Watermark: To add 
watermark on the document. 

Editing 

 

Add/Remove Bookmark: 
To add or remove bookmark 
on/from the document. 

 

 

Hide Annotations: To show 
or hide annotations made on 
the page. 
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3. Common Tasks 

This section lists out some common operations that can be performed while managing eViewer 
(SilverLight) application.   

3.1 View document through SharePoint 

Perform the following steps to open a document: 

1. Open Internet explorer and enter the document URL.  

For ex: http://mssp2k10/sites/edms/Shared%20Documents/Forms/AllItems.aspx. 

2. The SharePoint repository home screen appears. 

 

3. Select the site from the list of available sites under Libraries menu. 
4. The list of all available documents will be displayed at the right side of the SharePoint. 

5. Click on the ( ) button corresponding to the document that you want to view in the 
viewer.  

6. The selected document will be opened in the viewer in a separate window. 
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3.2 View Document in Stand Alone Mode 

The documents exist in the local machine can be viewed in the viewer too. Perform the following 
steps to open a document:  

1. On the File tab, click Open.  
2. A file to open box appears. 

 

3. Click Browse and navigate to the location of the document that you want to view. 
4. Click OK. 
5. The selected document will be opened in the viewer in a new tab. 

3.3 Export Document 

The document can be saved in one of the several formats to a folder on your desktop, or your hard 
disk drive or to a folder on a network drive. eViewer (SilverLight) supports saving a file in one of the 
following formats: 

 TIFF 

 TIFF_Single_Strip 

 JPEG 

 GIF 

 Bitmap 

 MODCA 

 MODCA_Single_Image 

 MODCA_Form 

 IOCA 

 PDF 
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Perform the following steps to export a document: 

1. On the File tab, click Export. 
2. The Export window will pop up from the right side. 

 

 

3. From the File Type drop down menu, select the format in which you want to save the file. 
4. Under Options group, do one of the following: 

 To save the current page only: Select Current Page. 

 To save the current document: Select Current Document. 

 To save some specified pages only: Select Selected Pages. Enter the page numbers in the below 
text box. 

5. Click Save.  
6. The application starts generating file. 
7. When the file gets generated, a Download File link will appear. 

 

8. Click Download File link. 
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9. The application will prompt ‘Do you want to save file’? 
10. Click OK. 
11. The Save As dialog box appears. 
12. Navigate to the location where you want to save the file.  
13. Click Save. 
14. The document has been saved in a specified format successfully. 

Perform the following steps to export multiple documents: 

1. On the File tab, click Export All. 
2. The Export Multiple Documents window will pop up from the right side. 

 Exporting multilple documents will merge all documents in one single specified document.  

 

3. From the File Type drop down menu, select the format in which you want to save the file. 
4. The list of all opened documents, with a checkbox corresponding to it, will appear under 

Documents group. 
5. Select or clear the checkboxes corresponding to the document that you want to save in other 

format. 
6. Click Refresh to add the new loaded/opened documents, if any.       
7. Click Save.  
8. The application starts generating file. 
9. When the file gets generated, a Download File link will appear. 
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10. Click Download File link. 
11. The application will prompt ‘Do you want to save file’? 
12. Click OK. 
13. The Save As dialog box appears. 
14. Navigate to the location where you want to save the file.  
15. Click Save. 
16. The documents have been saved successfully in a specified format.  
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3.4 Print Document 

The document can be printed by performing the following steps: 

1. On the File tab, click Print. 
2. The Print Document window will pop up from the right side. 

 

3. Under Print Range group, specify the portion of the document that you want to print.   

 To print all pages: Click All. 

 To print the current page only: Click Current Page. 

 To print some specific pages: Click Pages. Provide the page numbers or page range in the text 
box. 

4. Under Page Handling group, do the following: 

 Provide the number of copies that you want to print in Copies list box. Use ( ) to 
increase or decrease the number of copies. 
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 Collate: When referring to printing, collate is a term that describes how printed material 
is organized. For instance, if you had a document that is of five pages long and is opted to 
print multiple copies with collate enabled it prints pages 1,2,3,4 and 5 in that order and 
then repeat in the same order. However, if collate was disabled and you were printing 
three copies of those same five pages it would print pages in this order: 111, 222, 333, 444, 
and then 555.  
 

 From the Page Scaling drop down menu, select from the available options.  
 
Actual Size option- fits within the specified area of the page.   
Shrink oversized pages option- shrinks large pages to fit the currently selected paper size 
but doesn’t enlarge small pages. If an area is selected and is larger than the printable area 
of the currently selected paper, it’s scaled to fit the printable area.    
 

 Select or clear Include Annotations checkbox to allow or not to allow annotations to be 
print with the file.  

5. Under Alignment group, provide the horizontal and vertical alignment of the page. 
6. Click Print. 
7. The Print dialog box appears. 
8. Select the printer name (if it is not selected) from the list of printer’s name.  
9. Click OK. 

3.5 Search Text in a Document 

eViewer (SilverLight) provides a functionality through which any desired text in a document can be 
searched quickly. Perform the following steps to search the text in a document: 

1. On the Home tab, in Search group, click Quick Find. 
2. A pop up window appears on the top right side of the viewer. 

 

3. In the text box, provide the text that you want to search. 

4. Click ( ) and select the option as per your need: 

 Match case: If selected, then searches only for words that match the case of the word or 
phrase that has been typed in the text box. This means that the search becomes case-
sensitive. For example, if you search menu, the result includes all instances of menu with 
this exact spelling but not Menu or MENU. 

 Match whole word: If selected, restricts the search to whole words only. Whole words 
are words separated, on both sides, by a space. For example, if you search for edit, the 
result includes instances of edit only not editing, editor, editorial, and edited.   

 Find in whole document: If selected, searches text in the whole document. 
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 Search through OCR: If selected, extract text from images.  
 

5. Press Enter from the keyboard. 

6. If the matched text is found will be highlighted in a document. Use ( ) to go to the 
previous and next matching results.  

3.6 PDF Redaction  

Redaction, by definition, means hiding certain type of information from documents. Redacting a file 
allows you to hide the document's sensitive information. It can be used to cover information such as 
Social Security Numbers, competitive information and even images. Perform the following steps to 
redact document: 

1. On the Home tab, in the Editing group, click PDF Redaction. 
2. The PDF Redaction pop up window will appear from the right side and do one of the 

following: 

 

 To redact a word or phrase: Select Single word or phrase option and do the following. 

 Provide the text in the text box that you want to redact. 

 Select the option as per your need from the list of available search option. 
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Match case: If selected, then searches only for words that match the case of the word or 
phrase that has been typed in the text box. This means that the search becomes case-sensitive. 
For example, if you search menu, the result includes all instances of menu with this exact 
spelling but not Menu or MENU. 
 
Match whole word: If selected, restricts the search to whole words only. Whole words are 
words separated, on both sides, by a space. For example, if you search for edit, the result 
includes instances of edit only not editing, editor, editorial, and edited. 

 To redact any pattern such as Account Number, Social Security Number, etc.: Select Patterns option 
and do the following: 

 From the drop down menu, select the option. 

 Select option as per your need from the list of available patterns option:  
 
Reveal last digits: Last digits of the selected pattern will not be redacted i.e. it will be visible. 
For instance, if you had selected Credit Card option in Patterns, then the last four digits of the 
credit card number are visible i.e. they will not be redacted.   
 
Redact descriptor: Beginning part of the selected pattern will not be redacted.      

3. Click Highlight Color button under Format group to set the highlighted redacted color. 
4. Click Search. 
5. If the matched text is found will be highlighted in a document. 
6. Click Export to save the selected redacted text in a different format. 
7. The Export pop up window will appear. For details, refer Section Export Document. 
8. The selected text will be successfully redacted and is displayed in the exported document. 

 The redacted text will be displayed in the highlighted solid box in the exported document.  
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3.7 Metadata Information 

Metadata is the structured information that describes and manages an information resource. 
Metadata is often called data about data or information about information. The metadata 
information of any document can be viewed or edited as per the need. Perform the following steps 
to view or edit metadata information. 

1. Click Metadata Editor ( ) button displayed on the left side of the menu of the viewer. 
2. The pop up window will display depicting the metadata information of the document. 

 

3. The window will display read only and editable fields in a separate group. 
4. To edit any field, go to the editable fields group. 
5. Double click on the field of whose you want to edit information. 
6. Clicking the field will bring the field in an editable mode. 
7. Make required changes, if any. 
8. To save changes, release the mouse from the field. 

9. To close window, click ( ) button displayed at the top right side of the metadata editor 
window.   

10. Click Save. 
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3.8 Exploring Document from a SharePoint 

eViewer (SilverLight) allows viewing different documents from different sites within a viewer. 
Perform the following steps to view documents:  

1. Click Document Explorer ( ) button displayed on the left side of the menu of the 
viewer. 

2. The pop up window will appear. 

 

3. Expand the node and navigate the documents of the sites. 
4. Click on the document that you want to view in a viewer. 
5. The document will be opened in the viewer in a new tab in the Document View area. 

6. To close window, click ( ) button displayed at the top right side of the window. 
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3.9 Bookmarks 

If you’re working on a large document and need to return to specific locations in the document for 
editing or for some other purpose, Bookmark feature can prove invaluable. Rather than having to 
scroll through pages of the document, you can quickly return to marked locations to resume with 
the work. Perform the following steps to add bookmarks.   

1. Click Bookmarks Bar ( ) button displayed on the left side in the menu of the viewer or in 
Home tab, in Email group, click Bookmark. 

2. The Bookmark Bar window will pop up from the left side of the viewer. 

 

3. Click  to add bookmark on the pages. 
4. The Edit Bookmarks dialog box appears. 
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5. The total number of pages in a document will be displayed in the dialog box. 

6. To add bookmark on any page, hover mouse over  corresponding to the page on which 
you want to add bookmark. 

7. The red color button ( ) will be displayed corresponding to the page. 

8. Click on the ( ) button on the page on which you want to add bookmark. 

9. To enter any comments on the page, click  button corresponding to the page. 
10. The text box will pop up. 
11. Provide the suggestion or comments in the text box. 
12. The bookmark has been added on the selected page. 
13. Repeat step 6 to add multiple bookmarks. 

 

14. Click Update. 
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15. The bookmarks have been added on the selected page(s) and are displayed in the Bookmarks 
bar.  

 

16. To remove any added bookmark, click . 
17. The Edit Bookmarks dialog box appears. 

 

18. Click  corresponding to the page from which you want to remove bookmark. 
19. Click Update. 
20. The bookmark has been removed from the selected page. 
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21. To send the added bookmark on the page as a link to any other person via mail, select the 

checkbox corresponding to the page in the Bookmarks bar and click  option 
displayed at the bottom of the bar. 

 

22. The selected page bookmark link will be opened in your default mail box. 
23. Provide the name of the recipient to whom you want to send mail.  
24. Click Send. 
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3.10 Image Operations 

eViewer (SilverLight) provides several operations that can be executed to manipulate any type of file. 
Perform the following steps to do any image operation: 

1. On the Home tab do one of the following: 

 To rotate the page in a clockwise direction: In Rotation group, click . 

 To rotate the page in an anti-clockwise direction: In Rotation group, click

. 

 To rotate the page in a straight direction: In Rotation group, click . 

 To resize the document to fit entirely in the window: In Zoom group, click . 

 To resize the document to fit entirely in the width of the window: In Zoom group, click . 

 To resize the document to fit entirely in the height of the window: In Zoom group, click . 

 To bring the document into its actual size: In Zoom group, click . 

 To decrease the magnification percentage: In Zoom group, click . 

 To increase the magnification percentage: In Zoom group, click . 
 

2. On the View tab do one of the following. 

 To invert the color of an image: In Image Processing group, click . 

 To flip image horizontally: In Image Processing group, click .  

 To flip image vertically: In Image Processing group, click . 

 To bring document into its actual look: In Reset View group, click . 

 To split page horizontally: In Windows group, click .  

 To split page vertically: In Windows group, click . 

 To view/scroll two adjacent documents at the same time on the screen: In Windows group, click

. 
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3.11 Send Document Link via Email  

The new feature of sending document link via Email is a great way to provide access to different 
documents to anyone else who is authorized. Instead of sending document as an attachment, 
eViewer (SilverLight) provides facility to send the link of the document, that you are currently 
viewing as a link, via mail to any other person. Perform the following steps to send document link 
via mail: 

1. On the Home tab, in the Email group, click Link. 
2. The mail box, with link of the document in a body message, will display. 
3. Provide the mail ids of the person to whom you want to send mail. 
4. Click Send. 

3.12 Customize Toolbar 

Suppose you are using some commands frequently and you find a command, by navigating different 
tabs and then search in groups, a hectic one. For instance, for quickly saving your document, instead 
of clicking File tab, then clicking save option, if there is a Save icon that quickly saves data is a better 
option.  

eViewer (SilverLight) provides Quick Access Toolbar (QAT) that is very helpful for removing a step 
or two from commonly used tasks. In toolbar, you can insert icons that allow one click access to 
commonly used tools, but you can customize this toolbar with a number of different options that 
suits best as per your needs.  

Quick Access Toolbar (QAT) is the small row of icons, located at the top left corner of the 
application near the application logo button.  

 

By default, it has icons for Save, Save All, Quick Find, and Print. You can also add your favorite 
commands to the bar so that they are available at that time when you need regardless of which part 
of the ribbon you are using.  

Perform the following steps to add new icons from the toolbar: 

1. To the right of the Quick Access Toolbar, click the tiny arrow to open drop down menu.  
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2. Click the command for which you want add icon in the toolbar. 
3. Once selected, a new icon for it will display in the toolbar.  

Perform the following steps to remove an icon from the toolbar: 

1. To the right of the Quick Access Toolbar, click the tiny arrow to open drop down menu. 
2. Click the command for the icon which you want to remove. 

 The currently active icons have a check mark next to them. 

3. The icon for the selected command has been removed from the toolbar. 
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3.13 Extract Content 

Some files contain data that you can only view but can't access the content compressed in that files. 
eViewer (SilverLight) provides a convenient feature through which compressed data can be 
extracted from the file and can be used in a different file. Perform the below steps to extract content 
from the file: 

1. On the Home tab, in the Editing group, click Extract Content. 
2. Drag the mouse over the content that you wish to extract. 
3. The solid rectangle will be displayed over the selected content. 
4. The application starts extracting content from the file. 
5. Once extracted completely, the application displays the message Extracted content copied 

to clipboard. 
6. Now you can paste the copied content in the different file.     

 

3.14 Encryption and Decryption 

Encryption allows users to protect the text/content of the document. You can encrypt text with a 
password and can only be decrypted with a password. 

When you want to view the encrypted text, the encrypted text will pop up a dialog box to prompt 
you to enter the password. No one will be able to view the encrypted text without the password.  

Perform the below steps to encrypt text: 
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4. Annotation 

Annotations are comments, notes, explanations, or other types of external remarks that can be 
added to a selected part of the document to explain or illustrate its meaning. 

eViewer (SilverLight) provides tools to enable you to freely write your own comments to the 
document and can share with others. It provides facility to add comments via sticky notes, apply 
digital stamps and much more thus making eViewer (SilverLight) an ideal solution for business work 
flow. It also allows you to save, copy, paste and print annotation and contents. 

Annotations are saved within a file with the same name of the document with an extension .t_l in 
the current directory. Any annotation that is NOT burned-in (embedded) is put in this file. These 
marks can also be merged with the image data in a process known as burning-in.  

eViewer (SilverLight) has a full range of annotation tools. Following is a list of the annotation and 
markup tools included in eViewer (SilverLight), with a brief description of their functionality. 

4.1 Line 

This annotation tool draws a horizontal, vertical, or lines at 45° with adjustments: color and 
thickness. Perform the following steps to draw a line: 

1. In the Annotations tab, in Annotations group, click Line ( ) icon. 
2. Move the pointer to the place where you want the line to begin, and then drag the mouse to 

the place where it should end, and release the mouse button.  

 

Edit Properties of Line  

1. Select the annotation. 
2. The Line Properties window will pop up. 
3. To set the color of the line: Click on the Border color button. The color palette appears. Select 

the required color. 
4. To set the width of the line: Hover mouse over Border thickness button. The slide bar will pop 

up. Slide the bar to adjust the thickness of the line. 

5. Click ( ) to delete the annotation. 
6. Click anywhere on the viewer to close pop up. 
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4.2 Rectangle 

This annotation tool draws a rectangle with adjustments: line and fill color, thickness, and 
transparency. Perform the following steps to draw a rectangle: 

1. In the Annotations tab, in Annotations group, click Rectangle ( ) icon. 
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button. 

Edit Properties of Rectangle  

1. Select the annotation. 
2. The Rectangle Properties window will pop up. 
3. To set the color of the border of the rectangle: Click on the Border color button. The color palette 

appears. Select the required color. 
4. To fill color inside the rectangle: Click on the Background color button. The color palette 

appears. Select the required color. 
5. To set the opacity of the rectangle: Hover mouse over Opacity button. The slide bar will pop up. 

Slide the bar to adjust the opacity of the rectangle. 
6. To set the width of the rectangle: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the rectangle. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

 

4.3 Circle 

This annotation tool draws a circle with adjustments: line and fill color, thickness, and transparency. 
Perform the following steps to draw a circle: 

1. In the Annotations tab, in Annotations group, click Circle ( ) icon. 
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button. 

Edit Properties of Circle  

1. Select the annotation. 
2. The Circle Properties window will pop up. 
3. To set the color of the border of the circle: Click on the Border color button. The color palette 

appears. Select the required color. 
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4. To fill color inside the circle: Click on the Background color button. The color palette appears. 
Select the required color. 

5. To set the opacity of the circle: Hover mouse over Opacity button. The slide bar will pop up. 
Slide the bar to adjust the opacity of the circle. 

6. To set the width of the circle: Hover mouse over Border thickness button. The slide bar will 
pop up. Slide the bar to adjust the thickness of the circle. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

4.4 Arrow 

This annotation tool draws a horizontal, vertical or 45° arrow with adjustments: color and thickness. 
Perform the following steps to draw an arrow: 

1. In the Annotations tab, in Annotations group, click Arrow ( ) icon. 
2. Move the pointer to the place where you want the arrow to begin, and then drag the mouse 

to the place where it should end, and release the mouse button. 

Edit Properties of Arrow  

1. Select the annotation. 
2. The Arrow Properties window will pop up. 
3. To set the color of an arrow: Click on the Border color button. The color palette appears. Select 

the required color. 
4. To set the width of an arrow: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of an arrow. 

5. Click ( ) to delete the annotation. 
6. Click anywhere on the viewer to close pop up. 

4.5 Highlighter 

People use creative methods to draw attention to items of interest when they mark up a paper 
document, such as underlining, highlighting, circling words in a sentence. This annotation tool 
provides a similar feature for marking up information displayed in the viewer. Perform the following 
steps to draw highlighter: 

1. In the Annotations tab, in Annotations group, click Highlighter ( ) icon.  
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button.  

Edit Properties of Highlighter  

1. Select the annotation. 
2. The Arrow Properties window will pop up. 
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3. To set the opacity of the highlighter: Hover mouse over Opacity button. The slide bar will pop up. 
Slide the bar to adjust the opacity of the highlighter. 

4. To fill color inside highlighter: Click on the Background color button. The color palette appears. 
Select the required color. 

5. Click ( ) to delete the annotation. 
6. Click outside of the viewer to close pop up. 

4.6 Pen 

This annotation tool draws freehand lines and shapes with adjustments: color and thickness. 
Perform the following steps to draw a freehand line: 

1. In the Annotations tab, in Annotations group, click Pen ( ) icon. 
2. Move the pointer to the place where you want to begin and drag the mouse. The line will 

follow your mouse moves. Release the mouse button to end your drawing. 

Edit Properties of Pen  

1. Select the annotation. 
2. The Pen Properties window will pop up. 
3. To set the color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To set width: Hover mouse over Border thickness button. The slide bar will pop up. Slide 

the bar to adjust the thickness. 

5. Click ( ) to delete the annotation. 
6. Click anywhere on the viewer to close pop up. 

4.7 Text 

This annotation tool enters text with adjustments: size and color of the fonts and the text box. 
Perform the following steps to add any text: 

1. In the Annotations tab, in Annotations group, click Text ( ) icon. 
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button. 
3. Double click on the box to enter text.  
4. Click anywhere outside of the text box to finish editing the text.  
5. To re-edit text, just double click on the box. 
6. The text box can be repositioned by dragging the text box border and the size of the text 

box can be adjusted by dragging the selection handles. 

Edit Properties of Text  

1. Select the annotation. 
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2. The Text Properties window will pop up. 
3. To set the color of the box: Click on the Border color button. The color palette appears. Select 

the required color. 
4. To fill color in the text box: Click on the Background color button. The color palette appears. 

Select the required color. 
5. To set the opacity of the color of the box: Hover mouse over Opacity button. The slide bar will 

pop up. Slide the bar to adjust the opacity. 
6. To set the width of the box: Hover mouse over Border thickness button. The slide bar will pop 

up. Slide the bar to adjust the thickness of the box. 
7. To change the formatting of text: Click on the Font Settings button. The settings will popup. 

Make required formatting changes. 

8. Click ( ) to delete the annotation. 
9. Click anywhere on the viewer to close pop up. 

4.8 Stamp 

Just as you would use a rubber stamp, you can stamp images and text anywhere on a document. You 
can choose either from a list of pre-defined stamps or create your own stamps. Perform the 
following steps to add stamp:  

1. In the Annotations tab, in Annotations group, click Stamp ( ) icon. 
2. The list of all existing stamps under Pre-defined group will appear from the left side of the 

screen. 

 

3. Click User-defined. 
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4. The list of all user defined stamps, if any, will appear. 
5. Select the stamp that you want to use.  
6. Move the pointer to the place where you want to place the stamp. 

Edit Properties of Stamp  

1. Select the annotation. 
2. The Stamp Properties window will pop up. 
3. To set the border color of the stamp: Click on the Border color button. The color palette appears. 

Select the required color. 
4. To fill color in the stamp: Click on the Background color button. The color palette appears. 

Select the required color. 
5. To set the opacity: Hover mouse over Opacity button. The slide bar will pop up. Slide the bar 

to adjust the opacity. 
6. To set the width of the stamp: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the stamp. 
7. To set the formatting of stamp: Click on the Font Settings button. The settings will popup. 

Make required formatting changes. 

8. Click ( ) to delete the annotation. 
9. Click anywhere on the viewer to close pop up. 

 

To Create New Stamps 

All the existing stamps are located in the list of pre-defined stamps. If you want to add a specific 
stamp, then you can create a new stamp in EViewer (SilverLight). Perform the following steps to 
create a new stamp: 

1. In the Annotations tab, in Annotations group, click Stamp ( ) icon. 
2. The list of all existing stamps under Pre-defined group will appear. 
3. Click User-defined. 
4. The list of all user defined stamps, if any, will appear. 
5. Click Add New Stamp link displayed at the bottom of the pop up window. 
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6. The New Stamp text box will appear. 

 

7. Click ( ) button to provide the name of the new stamp. 
8. Clicking the button will bring the text box in an editable mode. 
9. Provide the name of the new stamp. 
10. To finish editing, press Enter. 

11. Click ( ) button to delete any newly created stamp. 

 Pre-defined stamps cannot be deleted. 
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4.9 Sticky Note 

Sticky Note is quite similar to typical sticky note that is stuck with the hard copy documents. It is 
more efficient and provides a natural and familiar means by which you can add and share comments 
in the form of a note anywhere on a page over text, images or blank spaces without editing the 
content. Perform the following steps to add a sticky note: 

1. In the Annotations tab, in Annotations group, click Sticky Note ( ) icon. 
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button.  
3. Double click on the box to enter text.  
4. Click anywhere outside of the text box to finish editing the text.  
5. To re-edit text, just double click on the box. 
6. The text box can be repositioned by dragging the text box border and the size of the text 

box can be adjusted by dragging the selection handles. 

Edit Properties of Sticky Note  

1. Select the annotation. 
2. The Note Properties window will pop up. 
3. To set the color of the box: Click on the Border color button. The color palette appears. Select 

the required color. 
4. To fill color in the text box: Click on the Background color button. The color palette appears. 

Select the required color. 
5. To set the opacity of the color of the box: Hover mouse over Opacity button. The slide bar will 

pop up. Slide the bar to adjust the opacity. 
6. To set the width of the box: Hover mouse over Border thickness button. The slide bar will pop 

up. Slide the bar to adjust the thickness of the box. 
7. To set the formatting of text: Click on the Font Settings button. The settings will popup. Make 

required formatting changes. 

8. Click ( ) to delete the annotation. 
9. Click anywhere on the viewer to close pop up. 
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4.10 Polygon 

The polygon is a series of closed, connected straight lines with the last line connecting back to the 
first line to form a complete shape. This tool gives you more control and flexibility. Perform the 
following steps to draw polygon: 

1. In the Annotations tab, in Annotations group, click Polygon ( ) icon. 
2. Move the pointer to the place where you want to begin drawing. Click the left button to 

create the start point, move the pointer, and click to create each segment.   
3. To exit, double click the left mouse button. 

Edit Properties of Polygon  

1. Select the annotation. 
2. The Polygon Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To fill color inside the polygon: Click on the Background color button. The color palette 

appears. Select the required color. 
5. To set the opacity of the inside color of the polygon: Hover mouse over Opacity button. The slide 

bar will pop up. Slide the bar to adjust the opacity. 
6. To set the width of the polygon: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the polygon. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

4.11 Polyline 

The polyline is a series of open, connected straight lines. Perform the following steps to draw 
polyline: 

1. In the Annotations tab, in Annotations group, click Polyline ( ) icon. 
2. Move the pointer to the place where you want to begin drawing. Click the left button to 

create the start point, move the pointer, and click to create each segment.   
3. To exit, double click the left mouse button. 

Edit Properties of Polyline  

1. Select the annotation. 
2. The Polyline Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To fill color inside the polyline: Click on the Background color button. The color palette 

appears. Select the required color. 
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5. To set the opacity of the inside color of the polyline: Hover mouse over Opacity button. The slide 
bar will pop up. Slide the bar to adjust the opacity. 

6. To set the width of the polyline: Hover mouse over Border thickness button. The slide bar will 
pop up. Slide the bar to adjust the thickness of the polyline. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

 Polyline annotations are similar to polygons, except that the first and last vertex are not implicitly 
connected 

 

4.12 Curve 

This annotation tool draws a curve with adjustment: fill color, opacity and thickness. Perform the 
following steps to draw curve: 

1. In the Annotations tab, in Annotations group, click Curve ( ) icon. 
2. Move the pointer to the place where you want to begin drawing.  
3. Click the left button to create the start point, move the pointer, mouse will follow your 

moves and click to create each segment.   
4. To exit, double click the left mouse button. 

Edit Properties of Curve 

1. Select the annotation. 
2. The Curve Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To fill color inside curve: Click on the Background color button. The color palette appears. 

Select the required color. 
5. To set the opacity of the inside color of the curve: Hover mouse over Opacity button. The slide bar 

will pop up. Slide the bar to adjust the opacity. 
6. To set the width of the curve: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the curve. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

 

 

4.13 Closed Curve 
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This annotation tool draws a closed curve with adjustment: fill color, opacity and thickness. Unlike 
the Curve annotation, the first and last endpoints are joined in a closed curve. The result is a 
smooth, continuous closed curve going through all the points. Perform the following steps to draw 
closed curve: 

1. In the Annotations tab, in Annotations group, click Closed Curve ( ) icon. 
2. Move the pointer to the place where you want to begin drawing.  
3. Click the left button to create the start point, move the pointer, mouse will follow your 

moves and click to create each segment.   
4. To exit, double click the left mouse button. 

Edit Properties of Closed Curve 

1. Select the annotation. 
2. The Closed Curve Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To fill color inside curve: Click on the Background color button. The color palette appears. 

Select the required color. 
5. To set the opacity of the inside color of the curve: Hover mouse over Opacity button. The slide bar 

will pop up. Slide the bar to adjust the opacity. 
6. To set the width of the curve: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the curve. 

7. Click ( ) to delete the annotation. 
8. Click anywhere on the viewer to close pop up. 

4.14 Text Pointer 

This annotation tool draws a text box with an indicative arrow to draw attention to an element on 
the page with adjustments: fill color, opacity and thickness. These are also called as callouts. 
Perform the following steps to draw text pointer: 

1. In the Annotations tab, in Annotations group, click Text Pointer ( ) icon. 
2. Move the pointer to the place where you want to begin and drag diagonally and release the 

mouse button. 
3. Double click on the box to enter text.  
4. Click anywhere outside of the text box to finish editing the text.  
5. To re-edit text, just double click on the box. 
6. The text box can be repositioned by dragging the text box border and the size of the text 

box can be adjusted by dragging the selection handles. 

Edit Properties of Text Pointer 

1. Select the annotation. 
2. The Text Pointer Properties window will pop up. 
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3. To set the border color: Click on the Border color button. The color palette appears. Select the 
required color. 

4. To fill color inside box: Click on the Background color button. The color palette appears. 
Select the required color. 

5. To set the opacity of the inside color of the box: Hover mouse over Opacity button. The slide bar 
will pop up. Slide the bar to adjust the opacity. 

6. To set the width of the box: Hover mouse over Border thickness button. The slide bar will pop 
up. Slide the bar to adjust the thickness of the box. 

7. To set the formatting of text: Click on the Font Settings button. The settings will popup. Make 
required formatting changes. 

8. Click ( ) to delete the annotation. 
9. Click anywhere on the viewer to close pop up. 

4.15 Ruler 

This annotation tool draws a line that is used to measure the distance between two points of the 
image with adjustments: color and thickness. Perform the following steps to draw ruler: 

1. In the Annotations tab, in Annotations group, click Ruler ( ) icon. 
2. Move the pointer to the place where you want the line to begin, and then drag the mouse to 

the place where it should end, and release the mouse button. 

Edit Properties of Ruler 

1. Select the annotation. 
2. The Ruler Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To set the width of the ruler: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the ruler. 

5. Click ( ) to delete the annotation. 
6. Click anywhere on the viewer to close pop up. 

4.16 Protractor 

This annotation tool easily and quickly measure angle of the image to the nearest degree with 
adjustments: color and thickness. It consists of two simple lines joined at a vertex to create an angle. 
Perform the following steps to draw protractor: 

1. In the Annotations tab, in Annotations group, click Protractor ( ) icon. 
2. Move the pointer to the place where you want to begin, and then drag the mouse; create an 

angle by joining two lines at a vertex. 
3. To exit, double click the left mouse button.  
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Edit Properties of Ruler 

1. Select the annotation. 
2. The Ruler Properties window will pop up. 
3. To set the border color: Click on the Border color button. The color palette appears. Select the 

required color. 
4. To set the width of the ruler: Hover mouse over Border thickness button. The slide bar will 

pop up. Slide the bar to adjust the thickness of the ruler. 

5. Click ( ) to delete the annotation. 
6. Click anywhere on the viewer to close pop up.  

4.17 Redaction 

Redaction, by definition, means hiding certain type of information from documents. Redacting a file 
allows you to hide the document's sensitive information. It can be used to cover information such as 
Social Security Numbers, competitive information and even images. Perform the following steps to 
draw protractor: 

1. In the Annotations tab, in Annotations group, click Redaction ( ) icon. 
2. Click and drag diagonally on the text or image that you want to redact and release the mouse 

button. 
3. Click Save. 
4. The solid rectangle will be displayed at the selected portion.  

 Once you redact any text or image, it will hide permanently. 
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